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Overview

This document will serve as the setup guide for the virtual lab environment of the Simwitty penetration testing internship. I will try to go through all the steps necessary to get the virtual network up and running so that the lab can be duplicated. For any questions or problems, or if you notice any omissions or mistakes, please contact me via email: jahoppe@gmail.com.

General Notes

· My host machine runs 32 bit XP pro with 3 GB of RAM and I eventually needed to move the wks-Matriux VM to my laptop in order to be able to do the lab work without overwhelming the host.

· Don’t forget to set the general preferences for VirtualBox under File -> Preferences. This will determine where the Default Hard Disk Folder (DHDF) and Default Machine Folder (DMF) are on your system. The HDF will take up the most room since this is where your VDI files will be stored and they can be multiple Gigabytes. The MF is mainly used for xml configuration files and log files, but there may be some snapshots saved there. Snapshots are saved when you 1) Manually save a snapshot or 2) Close the machine and choose “Save the machine state”. The snapshot files generally range from 70 – 400 Mb. If snapshots are taken manually, there can be multiple files. If you are only saving machine state on closing, there should be one per machine. Choose the location based on your space requirements but remember it because you will need to know the HDF location when you clone VDI files later via VBoxManage.

· When creating VMs and VDIs it is helpful to name them the same.

· When naming VMs and VDIs, avoiding spaces in the name will make using VBoxManage from the command line easier.

· VBoxManage is case sensitive.

· I did things in the wrong order by creating srv-DC first. Since it has two network interface cards and srv-SNORT has only one, cloning the former into the latter will result in ghosted adapters. If you create the VM for srv-SNORT first, install the OS, then install the guest additions, then clone the VDI for use in srv-DC it will save you some minor glitches (mainly numbering of interfaces and naming) concerning the network interfaces. This is because you will be adding an interface later rather than trying to delete one
. Since I didn’t discover this until after the fact, I don’t document the process in this [correct] order but it shouldn’t be very hard to adapt things. All you would have to do is add the NAT interface afterwards to srv-DC.
· Due to cloning of the srv-DC VDI to use for srv-SNORT (or vice-versa if you do things in correct order) you will see errors in the Administrative Events event log in event viewer on srv-SNORT. The source will be NETLOGON and the EventID will be 5516. The error is as follows: 

“The computer or domain SRV-SNORT trusts domain TEST.  (This may be an indirect trust.)  However, SRV-SNORT and TEST have the same machine security identifier (SID).  NT should be re-installed on either SRV-SNORT or TEST.”
According to a blog post by Mark Russinovich, this shouldn’t cause any problems. He does mention that it can be an issue with domain controllers and the domain SID. Since this is just a lab/testing setup, it’s my belief that the duplicate SID should be ok.

· To turn off automatic activation in Server 2008, locate the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\SL\Activation

Change the value named “Manual” from 0 to 1. If you don’t do this, the OS will automatically connect to the internet and activate itself 3 days after first login. This behavior is usually unwanted in a lab environment. By changing this, you will be given 60 days to evaluate before you are prompted to activate. You can rearm this timer 3 times using c:\windows\system32\slmgr.vbs. Note: You will still be notified each time you start the machine that “Windows could not activate”. This doesn’t seem to cause any problems.

· I choose to deactivate Automatic Updates on all VMs in this lab. The purpose for this to keep them at an unpatched level, so there are known weaknesses to exploit. Since they are unpatched and vulnerable, they should be kept separate from any production environment. This is meant as a LAB only.

Files to download

SQL Related:

· Windows Installer 4.5 - (Windows6.0-KB942288-v2-x86.msu)

· Microsoft .Net Framework 3.5 SP1 - (dotnetfx35setup.exe)

· Microsoft .NET Framework 3.5 Family Update for Windows Vista x86, and Windows Server 2008 x86 aka KB959209

· (Windows6.0-KB958481-x86.msu)

· (Windows6.0-KB958483-x86.msu)

· (NDP35SP1-KB958484-x86.exe)

· Microsoft® SQL Server® 2008 Express with Tools - (SQLEXPRWT_x86_ENU.exe)

Snort Related:

· Snort Installer

· http://www.snort.org/downloads - Snort_2_8_5_3_Installer.exe

· The Official Snort Ruleset (registered-user release)

· http://www.snort.org/snort-rules - snortrules-snapshot-2.8.tar.gz

· Security Update for SQL Server 2000 Service Pack 4 and MSDE 2000 aka KB960083 - (SQL2000-KB960083-v8.00.2282-x86x64-ENU.exe)

· This is needed because it contains a file necessary for Snort to talk to MSSQL

· The file can be opened with WinZip

· Locate the following file and extract it to the Snort\bin directory:

· i386\files\ntwdblib.dll (v.2000.80.2282.0)

· Microsoft® C Runtime Library
· I uploaded this to VirusTotal and it reported Result: 0/43 (0%)

· its MD5 also matches the one already on my system:

· 86f1895ae8c5e8b17d99ece768a70732 *msvcr71.dll

· version: 7.10.3052.4

· Optional: Wireshark

· http://www.wireshark.org/download.html
Create virtual machine to act as server/domain controller (srv-DC)

You must first set up the VM in VirtualBox. I am using version 3.1.4. The first thing you want to do is set your global preferences. On the File menu click ‘Preferences’. The General section will let you set your default folders for machines and virtual hard disks. In the ‘VRDP Authentication library’ box it should be set by default to say: VRDPAuth, just leave as is. The Input section will allow you to set the Host key if you are used to another VM environment, I leave mine as right ctrl. You can also set preferences for updates and language. The Network section is where you can add, remove, or edit settings for Host only Ethernet adapter networking.

Next you will set up the actual VM. Click the ‘New’ button and a wizard will start. Give the machine a name and then choose Operating System as Microsoft Windows and version as Windows 2008. Click next for memory settings. The default comes up as 512 MB, I increased mine to 768. Click next for hard disk settings. Check ‘Boot Hard Disk (Primary Master)’ and ‘create new hard disk’. The default/recommended size is 20GB (20480MB) I used this choice. Click next, then next once more and then choose ‘Dynamically expanding storage’. After pressing next, the location will be set with the OS name you selected and the disk size will be preselected to 20GB. Clicking next will show summary info, and clicking finish will show more summary info, but clicking finish once more will actually create the disk and machine and you will drop back to the VirtualBox GUI.

By right clicking the new machine and choosing settings you will be able to perform a more fine grained setup before you start the actual OS install. The detailed information from settings for my srv-DC VM is in Appendix A.

Install Server 2008 OS on this machine

At this point your VM should be in the state ‘Powered off’. Be sure you have followed the previous instructions to set the CD/DVD device so it sees the Server 2008 install media and then start the machine. The first time I tried the install, I set my CD/DVD device to a ‘virtual’ drive on the host and mounted the ISO for Server 2008 on that virtual drive. Part way through the install I got an error and the install could not continue. I went back and switched it so the VM used the ISO file directly and this was successful. This may just be a local issue. The Windows setup routine should start when the machine boots. Choose Server 2008 Standard (Full Installation). Accept the license. Where it gives you a choice between upgrade and custom, custom should be the only available choice. Choose Disk 0. Hopefully the OS install completes and you boot up into Windows. 

Install VirtualBox Guest Additions on srv-DC

Close the configuration window that starts automatically on boot. Close the Server Manager window that opens automatically when you close the first window. On the Device menu of the VM window, choose ‘Install Guest Additions’. This should pop up a window asking you what to do. Choose ‘Run VBoxWindowsAdditions.exe’. Hopefully this will install the Guest Additions then prompt you to reboot. After rebooting you can use the device menu again (CD/DVD Devices) and point it to whatever device you want. You should also probably set your time zone at this point.

To double check that everything went ok: in Server Manager, expand Diagnostics node and select Device Manager. If there are no problem devices, everything is probably ok. If you look in here before you install the Guest Additions you will see a couple problems, but the installation of Guest Additions should correct those. If all is ok, shut down the machine via the Start Menu and proceed to cloning the VDI.

Clone virtual hard drive of srv-DC to be basis for Snort server (srv-SNORT)

With the VM shut down and the VirtualBox GUI closed, open a command prompt and navigate to the Default Hard Disk Folder (DHDF) that was mentioned in the overview. It is helpful if you add the VirtualBox program directory to your path at this point:

set path=%path%;"C:\Program Files\Sun\VirtualBox"
You must use full paths when you perform this operation e.g. 

vboxmanage showhdinfo C:\Bin\VirtualBox\VDI\srv-DC.vdi

The following command will clone the hard drive that we just installed Server 2008 on and save us having to do another full install:

vboxmanage clonehd C:\Bin\VirtualBox\VDI\srv-DC.vdi C:\Bin\VirtualBox\VDI\srv-SNORT.vdi

Once this operation finishes you should be left with a new VDI file. We will have to add this to the Virtual Media Manager in the VirtualBox GUI and then setup a new machine to use it. This new machine will be our srv-SNORT.
Create virtual machine to act as Snort server (srv-SNORT)

This just follows along the same routine as the last VM we created. The only difference will be when the wizard asks about a hard drive. Here you will tell it to use an existing hard drive. Since we haven’t yet imported the srv-SNORT.vdi into the Virtual Media Manager, it won’t be available in the drop down box. Instead press the folder icon and Virtual Media Manager will open. Here we add the VDI and then select it. Proceed through the wizard. When it finishes, right click the srv-SNORT machine and choose settings. The only thing we have to change has to do with the network adapters. This VM will have only one, and it will be set to the internal network of ‘simwit’. Remember that because this is a cloned drive, the password you already set for the administrator account on srv-DC will be the same for srv-SNORT. Save your changes and we will proceed to installing ADDS on srv-DC.
Install Active Directory Domain Services (ADDS) on srv-DC

Start up the srv-DC VM. There are two things to do before installing ADDS. The first thing to do is set the network interfaces properly. Click Start -> Right click network -> click properties. In Network Connections window click manage network connections. Hopefully there are two connections listed, Local Area Connection and Local Area Connection 2 (hereby one and two). One should be the Intel PRO/1000 and two should be the AMD PCNET. I rename one to OutsideNIC  and two to InsideNIC
· Right click one (OutsideNIC) and choose properties.

· On networking tab, uncheck all except TCP/IPv4.

· Double click TCP/IPv4 to open the setting window.

· On General tab, select Obtain an IP address Automatically and Obtain DNS server address automatically (this will change later).

· Click Advanced to open settings window.

· On DNS tab: uncheck append parent,uncheck Register connection.
· On WINS tab uncheck LMHOSTS and disable NetBIOS.

· OK, OK, OK and back to Network Connections window.

· Right click two (InsideNIC) and choose properties.

· Leave all boxes checked.

· Double click TCP/IPv4 to open the setting window.

· Set a static address of 192.168.2.1 with mask 255.255.255.0, leave gateway blank.

· Leave DNS server blank.

· Click Advanced to open settings window.

· On DNS tab: set DNS suffix = test.local, check both register and use.
· On WINS tab uncheck LMHOSTS and disable NetBIOS.

· OK, OK, OK and back to Network Connections window.

Click the Advanced menu and choose Advanced Settings be sure two (InsideNIC) is first and one (OutsideNIC) is second. In the bindings for two, everything is checked and IPv4 is first in each subgroup.

The second thing is to change the actual computer name. Press Start -> Right click computer -> choose properties. In System window, click advanced system settings. Click the Computer Name tab. Set the computer name to be the same as the VM name. For me this is srv-DC. You will have to restart and then we can install ADDS.

In Server Manager, select roles and then click add roles. Choose Active Directory Domain Services and press next. When installing AD, you can’t install any other roles at the same time. Read the text, press next. Read again, press next. Read again and press install. Eventually you will have a window pop up that has a link which allows you to close window and launch dcpromo, click this. In the next window, uncheck advanced mode and press next. Read and press next. Choose Create new domain in new forest and press next. The settings to use are:

· FQDN = test.local

· Forest Functional Level = Server 2003

· Domain Functional Level = Server 2003

Select DNS server when given the opportunity. Ignore the warning about dynamic IP address and click yes. Use defaults for everything, click next. Set the password and click next. Read and click next. Read and click finish. Choose restart now.

Install and configure DNS Server on srv-DC

The DNS server gets installed as the final bit of ADDS installation, now we must configure it.

· In Server Manager expand roles -> DNS server -> DNS and Right click on server name, choose properties.

· On the Interface tab, select “only the following” and uncheck the x.x.x.x (OutsideNIC) interface.

· On the advanced tab, uncheck round robin
. Click ok to close that window.

· Once again Right click the server name and choose “Configure a DNS server”.

· Choose “Create forward and reverse lookup zones”, click next.

· Choose Yes, create..., next.

· Choose “Primary Zone” and check “store the zone...” Select  “To all in this domain”, next.

· Name the zone test.local, next.

· Choose “Allow only secure dynamic updates”, next.

· Select Yes, “create reverse”..., next.

· Choose primary and store in AD, next.

· Choose “to all in this domain”, next.

· Choose IPv4, next.

· For Network ID use 192.168.2. Choose “allow only secure”, next.

· Choose no for forwarders.

· Click Finish.

Possible Problems

At this point I got an error and it said the zone couldn’t be created because it already existed. After closing all windows and message boxes, I ignored the error. I then Right clicked Reverse Zones and chose new zone. I then redid the latter half of what I just walked through and the reverse zone was created ok.

Forwarders

If you want internet access out the public interface you need to set a forwarder, I use openDNS. This can be set in the properties of the server on the forwarders tab.

Take a look at the records that have been created in your zones and be sure everything looks ok. At this point, I believe the DNS server changes the DNS server settings of both interfaces on the server and sets them to 127.0.0.1. We now need to go back into interface setup and configure both NICs to use 192.168.2.1 as the DNS server. Next we install and configure DHCP.

Install and configure DHCP Server on srv-DC

The DHCP server will be used to manage the addresses available on the internal network simwit. It will suppy the addresses and reservations to RRAS NAT.

· In Server Manager, go to roles/add role.

· Choose DHCP click next.

· In the Select Network Connection Bindings window, choose 192.168.2.1 IPv4; next.

· Parent Domain: test.local, Preferrred DNS 192.168.2.1; next.

· Say no to WINS; next.

· Add a scope: address range 192.168.2.50-192.168.2.100; OK; next.

· Choose Disable DHCP Stateless...; next.

· Use Current Credentials; next.

· Install.

Once it installs, expand all the nodes until you can see a section called Reservations. Right click and choose new reservation with the following settings name:srv-SNORT, address 192.168.2.100, mac: if you can probably find this easiest by opening a cmd prompt on the host, cd into the VirtualBox program directory and type

vboxmanage showvminfo srv-SNORT --machinereadable | findstr /i macadd 

Click ok to exit the configuration.

Install and configure Network Policy and Access Services (NPAS) on srv-DC

The NPAS module is what will provide RRAS and NAT, which is needed to link the OutsideNIC and InsideNIC (and have a successful lab).

· In Server Manager select roles then click add new role.

· Choose Network Policy and Access Services. Read then click next.

· For sub roles, select only Routing and Remote Access and click next.

· Click Install.

· Once Installation is done, expand roles in Server Manager.

· Expand NPAS, select RRAS, Right click and choose Configure and Enable...

· Read text, press next.

· Choose Network Address Translation, press next.

· In the window “Use this public interface”, select the Intel Pro/1000 (OutsideNIC) at x.x.x.x, click next.

· Click Finish.

· Once the install completes, expand NPAS -> RRAS -> IPv4 and Right click NAT, choose properties. 

· On the Address Assignment tab, uncheck Automatically
· On the Name Resolution tab, uncheck Clients using
· Click OK to finish and it should go through the process of starting up and initializing the services.

Next we need to setup srv-SNORT and check connectivity. Leave srv-DC running, but minimize it out of the way.

Setup network interface on srv-SNORT and confirm connectivity.

Now start up srv-SNORT. The password should be the same as the one you set on the first server. Once it boots up, you can set the timezone. Then start->run->ncpa.cpl to open the network connections window. Since this VM (and the two workstations we will setup) only have one NIC apiece, there is no real need to rename them. On this server though, you may find the connection called local area connection 2 even though there isn’t another one. If you try and rename it by deleting the 2, you are told another connection already exists. If this is the case and it bothers you, rename it to something else. This interface will be setup with all items enabled. The only one of those items we should have to configure is the TCP/IPv4 item. Since we made a reservation for this computer with DHCP on srv-DC the adapter should be left to obtain IP address and DNS server automatically. Click advanced and be sure it is set to register in DNS and to disable NetBIOS. Click OK to close all that and then use whatever method you prefer to check connectivity through srv-DC and out to the internet e.g. nslookup www.yahoo.com.

On this VM I also create an account for myself called jeff-snort. I add myself to the administrators group and keep all the default user account settings, except I set the password to never expire and I turned off UAC on this account. The reason for this is to reduce confusion from working with a bunch of Administrator accounts.

Setup an OU for Simwitty in AD and add some accounts.

Back to srv-DC, expand Active Directory Domain Services in Server Manager until you see test.local. Right click test.local, choose new->Organizational Unit and name it Simwitty. I create the following accounts within the OU Simwitty:

· Computers:

· srv-SNORT

· wks-XP1

· wks-XP2

· Users:

· jeff-dc

/* for srv-DC */
· jeff-snort
/* for srv-SNORT */
· usr1

 /* for wks-XP1 */
· usr2

/* for wks-XP2 */
I also created a Domain Local Security group named SimwittyGroup and added all the above computers and users to the group. In order to add srv-DC to the group, you have to enable advanced view in Active Directory Users and Computers (ADUC), view->advanced features. Once this is done, a container for Domain Controllers is visible under test.local. It contains srv-DC, which you can right click and choose ‘add to group...’. All of the computers are members of Domain Computers and SimwittyGroup. All Users are members of Domain Users and SimwittyGroup. For the two jeff accounts, they are also members of Domain Admins group, and that is set as the primary group for each.

Next I will join srv-SNORT to the test.local domain. Press Start->Right click computer->properties. Click change settings under computer name section. System Properties window will open, click change. Within Member of, select domain and fill in test.local; press OK With the accounts I set up, I used jeff-snort to authorize joining the domain. Restart computer when prompted.

When the computer restarted, I logged on as srv-SNORT\jeff-snort.

Add IIS role to srv-SNORT

I thought it would be good to install IIS as another attack surface. I never really got around to attacking it in my lab but hopefully someone in the future will. If you have no intention of working with IIS, you can skip this.

· In Server Manager, select roles

· Choose add roles, then select Web Server (IIS).

· When prompted, choose add required features, then click next.

· Read the text and click next again.

Now you are presented with a list of choices. I left everything at the default: Static Content, Default Document, Directory Browsing, HTTP Errors; HTTP Logging, Request Monitor; Request Filtering; Static Content Compression; IIS Management Console; click next; review, click install. 

Install SQL Server on srv-SNORT.

Microsoft has set up the SQL Server 2008 Express edition to use the ‘Web Platform Installer’ which can be problematic in our situation. I downloaded the actual installation file from the Microsoft download center as noted in the Files to Download section. There are prerequisites listed on that site that include: Microsoft .Net Framework 3.5 SP1, Windows Installer 4.5, and Windows PowerShell 1.0. You can use Server Manager to install PowerShell on the Machine (via add features).
Note: Before starting any of this, I am assuming I need to turn off the lock down of IE in Server 2008. You do this from Server Manager in the Security Information section. Click Configure IE ESC and choose off for Administrators.

· Install Windows Installer – (Windows6.0-KB942288-v2-x86.msu)

· Restart VM

· Install Microsoft .Net Framework 3.5 SP1 - (dotnetfx35setup.exe)

· There is the following Warning in the instructions for .NET 3.5:

· “IMPORTANT: After installing the .NET Framework 3.5 SP1 package (either the bootstrapper or the full package) you should immediately install the update KB959209 to address a set of known application compatibility issues.”

· Restart VM

· Install Microsoft .NET Framework 3.5 Family Update for Windows Vista x86, and Windows Server 2008 x86 aka KB959209

· This has the Warning/Instruction:
· Please download and install all 3 updates available in the section titled Files in This Download. These updates should be installed in the following sequence: 

· Install the update for the .NET Framework 2.0 Service Pack 2 - Windows6.0-KB958481-x86.msu 

· Install the update for the .NET Framework 3.0 Service Pack 2 - Windows6.0-KB958483-x86.msu 

· Install the update for the .NET Framework 3.5 Service Pack 1 - NDP35SP1-KB958484-x86.exe 

· Install Microsoft® SQL Server® 2008 Express with Tools - (SQLEXPRWT_x86_ENU.exe)

After running the file, you are presented with the SQL Server Installation Center. On the left side click installation, then click “New SQL Server standalone installation”. This brings up a Setup Support Rules window that tells you if you need to fix any problems before the install. If everything is ok, click OK. Next up is a window to insert the product key or choose a free version. With this install, options are greyed out and it is preselected for “Express with Advanced Services”; click next. Agree to license; click next, click install. Eventually another Setup Support Rules window appears; click next. Now you are at:

/* note: there is a good reference at http://msdn.microsoft.com/en-us/library/cc281727.aspx */

· Feature Selection. Not exactly sure what to select here, so I choose Database Engine Services and Management Tools – Basic; click next.

· Instance Configuration: select Default instance; Instance ID: I leave this as SQLExpress and leave instance root directory at the default C:\Program Files\Microsoft SQL Server\. Click next; view summary; click next.

· Server Configuration:

· Service Accounts tab: I only have two services listed on this tab. The account name for SQL Server Database Engine is blank, so I assume I must choose one. I pick: NT AUTHORITY\NETWORK SERVICE with Automatic startup and leave the password blank. For the SQL Server Browser, the account name is set (and can’t be changed) to NT AUTHORITY\LOCAL SERVICE The startup type is set to Disabled so I leave it. /* note: I later used the SQL Server Configuration Manager to set this to manual, just so it’s available to be started if need be */
· Collation tab: I don’t do anything; click next. 

· Database Engine Configuration: 

· Account Provisioning Tab: select Mixed mode. Password testing123. Add current user as a SQL administrator.
· Data Directories tab: Left everything as default.
· FILESTREAM Tab: This doesn’t sound like anything necessary. Leave disabled. Click next.
· Error and Usage Reporting: Leave unchecked; click next.
Now you arrive at another Installation Rules page the will tell you if there are errors at this point. Click next. This gives you a summary page with the path to the configuration file, mine is:

C:\Program Files\Microsoft SQL Server\100\Setup Bootstrap\Log\20100308_195112\ConfigurationFile.ini 

Click install. My installation was successful. Exit the installer then exit the Installation Center. 

Configuration of SQL Server

To configure the services, start SQL Server Configuration Manager. Expand SQL Server Network Configuration. Select Protocols for SQLEXPRESS in the left pane then double click TCP/IP in the right pane.

· protocol tab:  leave at defaults.

· IP Addresses tab: Mine shows 6 separate IP Address sections and an IPAll section. The only thing I changed was the section for IP Address 127.0.0.1. (IP4 on my system). This section should be as follows:

· Active: Yes

· Enabled: Yes

· IP Address: 127.0.0.1

· TCP Dynamic ports: 0

· TCP Port: 1433

Close all property pages and close SQL Server Configuration Manager. Open SQL Server Management Studio. 

Install Snort on srv-SNORT.

Get the latest version of Snort. I am using:

version: Version 2.8.5.3-ODBC-MSSQL-FlexRESP-WIN32 GRE (Build 124)

choose "I need support for logging to Microsoft SQL Server."

choose all components

choose base dir Basepath I chose Basepath = C:\Opt\Snort.

Hierarchy as follows:


C:\OPT


+---Snort



+---bin



+---contrib



+---doc



¦   +---signatures



+---etc



+---lib



¦   +---Snort_dynamicengine



¦   +---Snort_dynamicpreprocessor



+---log



+---preproc_rules



+---rules



+---schemas
The following creates backups of all config files:

Open command prompt and cd into Basepath\etc directory,

type following command:

C:\Opt\Snort\etc>for %i in (*) do @copy %i %i.orig
Copy the ntwdblib.dll and msvcr71.dll (These are mentioned and linked in the Files to Download section) into Basepath\bin
My ntwdblib.dll is 2000.80.2039.0 and msvcr71.dll is 7.10.3052.4

This isn't necessary if you install as service immediately, but it makes testing from command prompt easier

add C:\Opt\Snort\bin to PATH

set path=%path%;c:\Snort\opt\bin

Install Wireshark on the machine

This is optional but is handy for troubleshooting and to give access to winpcap which is needed by Snort.

· Agree to license.

· Select all components.

· Select: Start Menu, Quick Launch, and Associate filetypes.

· Use default directory.

· Install WinPcap 4.1.1.

· Automatically start driver.

Snort.conf adjustments:

This section details the changes I made to snort.conf, along with some commentary. Notepad++ is very useful for working with snort.conf

Version of conf file, as per line 2 is:

http://www.Snort.org     Snort 2.8.5.3 Ruleset

This is the version that comes with the install binary. I have reason to believe that version included in rules is FUBAR, more later.

Line numbers courtesy Notepad++. Set language as C# and it is a lot easier to read ;)

line 5 changed from:


# $Id$


to


# $Id$ jah-mod

line 120 changed from:


var RULE_PATH ../rules


to


var RULE_PATH Basepath\rules
line 121 changed from:


var PREPROC_RULE_PATH ../preproc_rules


to


var PREPROC_RULE_PATH Basepath\preproc_rules
line 204 changed from:


dynamicpreprocessor directory /usr/local/lib/Snort_dynamicpreprocessor/


to


dynamicpreprocessor directory Basepath\lib\Snort_dynamicpreprocessor
line 214 changed from:


dynamicengine /usr/local/lib/Snort_dynamicengine/libsf_engine.so


to


dynamicengine Basepath\lib\Snort_dynamicengine\sf_engine.dll
line 699 changed from:


# output database: log, mssql, dbname=Snort user=Snort password=test


to

output database: log, mssql, dbname=Snort host=srv-snort\SQLExpress \

                                user=SnortUser password=snort1test2 sensor_name=sensor-01

The bit with the SQLEXPRESS tacked on the end depends on your install of SQL Server. If you see that listed in the server name when you start SQL Server Management Studio, then use it; if not, don’t. Note that the backslash after SQLExpress has a space before it. That backslash is NOT path related, it is just to escape the line ending from Snort. I originally set the host to 127.0.0.1 but experienced problems, so I set it to the machines DNS name (srv-snort) and it seemed to work fine.

line 772 changed from:


include classification.config


to


include Basepath\etc\classification.config
line 780 changed from:


include reference.config


to


include Basepath\etc\reference.config
lines 858-870 changed from:


commented to uncommented. This includes all rules

Change all instances of $RULE_PATH/ to $RULE_PATH\
lines 873,874


Uncomment and change $PREPROC_RULE_PATH/ to $PREPROC_RULE_PATH\

INSTALL RULES

In this section I detail installing the rules for Snort, along with some thoughts on the matter. There is very little documentation that I could find for some of the details that I comment on.

Get rules file Snortrules-snapshot-2.8.tar.gz from Snort.org (mentioned in Files to Download section)

Extract to a convenient directory away from Snort install, I chose Snortrules-snapshot-2.8 in my VirtualBox shared directory

I believe that everything under so_rules directory is *nix specific (although like everything else with Snort, this is terribly documented for Windows), so I delete that directory.

I believe that the doc folder in the rules snapshot contains old and outdated information.

Reason for this belief:

e.g. original \Snort\doc\CREDITS timestamp: Tuesday, July 21, 2009, 7:00:50 AM

\Snortrules-snapshot-2.8\CREDITS timestamp: Monday, September 13, 2004, 11:44:49 AM

rule snapshot contains various files referencing old things like README.stream4

Copy the 58 files from the snapshot \rules\ folder into Basepath\rules
The \etc\ folder is a tough call... here is a diff I did. A leading i means insignificant difference, leading s means significant difference. For the significant ones I did a line count:

# i
Files etc\classification.config and snapshot-2.8\etc\classification.config differ

# s
Files etc\gen-msg.map and snapshot-2.8\etc\gen-msg.map differ

#

wc -l etc\gen-msg.map snapshot-2.8\etc\gen-msg.map
#

312 etc\gen-msg.map
#

230 snapshot-2.8\etc\gen-msg.map
# i
Files etc\reference.config and snapshot-2.8\etc\reference.config differ

# s
Files etc\sid-msg.map and snapshot-2.8\etc\sid-msg.map differ

#

wc -l etc\sid-msg.map snapshot-2.8\etc\sid-msg.map
#

2527 etc\sid-msg.map
#

15146 snapshot-2.8\etc\sid-msg.map
# s
Files etc\Snort.conf.orig and snapshot-2.8\etc\Snort.conf differ

#

wc -l etc\Snort.conf.orig snapshot-2.8\etc\Snort.conf
#

882 etc\Snort.conf.orig
#

1022 snapshot-2.8\etc\Snort.conf
# s
Files etc\threshold.conf and snapshot-2.8\etc\threshold.conf differ

#

wc -l etc\threshold.conf snapshot-2.8\etc\threshold.conf
#

67 etc\threshold.conf
#

61 snapshot-2.8\etc\threshold.conf
#

#
Only in snapshot-2.8\etc\: generators

#
Only in snapshot-2.8\etc\: Makefile.am

#
Only in snapshot-2.8\etc\: open-test.conf

#
Only in snapshot-2.8\etc\: sid

All these differences make it a tough call, so here is what I'm going to do:

· insignificant difference, keep original

· gen-msg.map, keep original

· sid-msg.map, use snapshot version

· Snort.conf, keep original (with my modifications)

· threshold.conf, keep original

as for the 4 files that were only in the snapshot (generators, Makefile.am, open-test.conf, sid), I will move those over too.

# The signatures folder that comes with the snapshot is a God awful thing. It is 62 MB, but worse, is comprised of 15,955 files. I am hoping that, in the grand tradition of Snort, this is some unneccessary relic. For now I will leave it off of the Snort server and see what happens.

# edit: This appears to be the case. The signature files have more detailed information about each rule but even without those files, the database still gets enough logged to see what’s happening

Setup Database

These instructions are taken from Snort_Integration_v2__jah_.doc The original version was done by Wolfgang Goerlich and I made a couple small modifications to fit with this lab.

1. Ensure that the SQL Server supports local SQL accounts.
SQL Server Management Studio
Connect to the SQL server
Right-click the server, Properties
On Server Properties, select the Security page
Check [x] SQL Server and Windows Authentication Mode
Click OK and restart the SQL Server services 

2. Create a Snort user in SQL Server.
SQL Server Management Studio
Connect to the SQL server
Expand Security > Logins
Right-click, New Login... 
Login name: SnortUser
[x] SQL Server authentication
Password: snort1test2
Uncheck:
[-] Enforce password policy
[-] Enforce password expiration
[-] User must change password at next login
On Server Roles, check [x] sysadmin to temporarily grant SnortUser the
ability to create databases
Click OK 

3. Create the Snort database in SQL Server.
SQL Server Management Studio
Login using SQL Server Authentication with the SnortUser and password
expand Databases
Right-click, New Database
General page, Name: Snort
Options page, Recovery model: Simple
Click Ok.
Click to select Snort, then click New Query from the toolbar
Open Basepath\schemas\create_mssql and copy it into the new query
Execute the new query on the Snort database logged on as SnortUser
Expand to Databases > Snort > Tables and confirm the tables are present
Disconnect SQL Server Management Studio from the database as SnortUser

4. Set the least privilege for SnortUser.
SQL Server Management Studio
Connect using Windows Authentication
Expand Security > Logins
Right-click SnortUser, Properties
Server Roles page: uncheck [-] sysadmin

Test Run

Ran with command line:

Snort -T -c C:\Opt\Snort\etc\Snort.conf
result:

"Decoding LoopBack on interface NULL"

If this works with no errors, the following will test connectivity to the database:

Snort -dev -c c:\Opt\Snort\etc\Snort.conf -l c:\Opt\Snort\log

If this works ok, the following should install Snort as a service:

Snort /service /install -i 1 -de -c c:\Opt\Snort\etc\Snort.conf -l c:\Opt\Snort\log

To start the service and check for errors, type:

net start snortsvc

You should hopefully see:

The Snort service is starting.

The Snort service was started successfully.

If not, you will have to check the event viewer application log and troubleshoot any issues.

Create VM for Matriux and Install Matriux.

Create VM

Follow the same basic procedure for creating a VM as in Step 1. Here are the settings I used :

· Name: wks-Matriux

· OS: Linux

· Version: Ubuntu

· Base Memory: 384 MB

· HD Size: 10GB

Once the base machine is created, right click it and open the settings for the machine. I will only point out the changes I made from the defaults.

· Boot Order: remove floppy

· Storage: Remove all controllers

· Add a SATA controller and attach the VDI to it

· Add IDE Controller (ICH6) and for now attach the Matriux ISO to it

· Adapter: Bridged, choose appropriate host adapter

· Type: PCnet-Fast III

Install Matriux and the Guest Additions

· Start the VM and install Matriux using the tutorial at the Matriux Forums (starts at about step #39).

· In the file /etc/apt/sources.list change all occurances of http://in.archive.ubuntu.com to http://us.archive.ubuntu.com (I do this via sudo scite).

· In order to assure DHCP works, edit /etc/network/interfaces to include 

auto eth0

iface eth0 inet dhcp

· Also edit /etc/dhcp3/dhclient.conf I backed up the original and then edited the file to read:

option rfc3442-classless-static-routes code 121 = array of unsigned integer 8;

send host-name "wks-Matriux";

request subnet-mask, broadcast-address, time-offset, routers,


domain-name, domain-name-servers, domain-search, host-name,


interface-mtu, rfc3442-classless-static-routes, ntp-servers;

interface eth0

· Install the Guest Additions using the tutorial at the same location as above.

· If you get an error in the first step, try:
sudo apt-get --fix-missing install build-essential linux-headers-generic
· Restart the VM

Install newest version of Metasploit Framework

Before doing anything, run

sudo apt-get update

sudo apt-get upgrade

140 upgraded, 0 newly installed, 0 to remove and 11 not upgraded.

Need to get 152MB of archives.

After this operation, 1847kB of additional disk space will be used.

Do you want to continue [Y/n]?

Choose yes and wait for it to finish, then restart the VM.

In order to run Wireshark as non-root (not really essential in a controlled lab, but I do it anyway) run

apt-get install libcap2-bin

After installing this, type the following command:

sudo setcap 'CAP_NET_RAW+eip CAP_NET_ADMIN+eip' /usr/bin/dumpcap

There is a general guide to follow for the process of installing Metasploit on Ubuntu at the Metasploit wiki. the actual series of commands I used follows:

sudo apt-get install ruby libopenssl-ruby libyaml-ruby libdl-ruby libiconv-ruby libreadline-ruby irb ri rubygems

sudo apt-get install subversion

sudo apt-get build-dep ruby

sudo apt-get install ruby-dev libpcap-dev

sudo apt-get install rubygems libsqlite3-dev

sudo gem install sqlite3-ruby

The Framework section of this wiki page is a bit out of date. It refers to downloading a gzipped file, but the current version of the framework is a runnable archive (framework-3.3.3-linux-i686.run). This being the case, all you have to do is download the file, chmod it to be executable and run it: sudo ./framework-3.3.3-linux-i686.run
· choose yes to autoupdate

· choose yes to update now

Install newest version of Nmap

First, remove the old version: sudo apt-get remove nmap Then do the following:

Change to home directory:

cd
mkdir SVN_Files

cd SVN_Files

svn co --username guest --password "" svn://svn.insecure.org/nmap/

cd nmap

sudo ./configure

sudo make

sudo LINGUAS=”en” install

nmap –version

Nmap version 5.21 ( http://nmap.org )

Check database after a scan

Since wks-Matriux is set up with a bridged adapter, it won’t be possible to scan internal machines through the gateway srv-DC. In order to do a test scan, temporarily attach the NIC on srv-Matriux to internal network simwit. Start srv-DC, srv-SNORT, and wks-Matriux. Execute the following Nmap scan:

sudo nmap -v -n -sT -A -F -oA original 192.168.2.100

Open SQL Server Management Studio and connect to the server. Choose View->Object Explorer Details. Expand Databases then expand Snort. Select Tables. In the right pane, R. click on the column header area and select Row Count. This will show that there are numerous tables in the Snort database that now have multiple rows. If you right click the signature table and choose Select Top 1000 Rows you can see some of the signature names, such as “(portscan) Open Port”.

To clear the tables (except for detail, encoding, and schema) you can execute the following SQL statement (and save for later):

DELETE from data

DELETE from event

DELETE from icmphdr

DELETE from iphdr

DELETE from opt

DELETE from reference

DELETE from reference_system

DELETE from sensor

DELETE from sig_class

DELETE from sig_reference

DELETE from signature

DELETE from tcphdr

DELETE from udphdr

Create VM for XP workstations and install OS

This follows along the same lines as creating the other VMs. The settings used for the VMs are as follows:

· Name: wks-XP1 and wks-XP2

· OS: Windows

· Version: Windows XP (Service Pack 2)

· Base Memory: 192 MB

· HD Size: 10GB

· Boot Order: remove floppy

· Storage: Remove all controllers

· Add a SATA controller and attach the VDI to it

· Add IDE Controller (ICH6) and for now attach XP installation ISO to it /* you will have to add your XP ISO to the Virtual Media Manager */
· Adapter: Internal Network name simwit

· Type: PCnet-Fast III

Install and configure the operating System. Just a plain vanilla install. Create a user for each computer, usr1 and usr2 respectively (non-admin). Set the NIC on each computer to use DHCP for IP and DNS. Set DNS to append suffixes and register. Disable NetBIOS. For the firewall settings: exceptions tab, allow all four listed exceptions; advanced tab, log dropped packets, check all ICMP types except [router request, redirect, and packet too big].

Join the computer to the test.local domain. Make sure srv-DC is running. Log on to each workstation as Administrator. Start->right click computer->properties. Computer Name tab, change. Select Domain, fill in test.local. Supply credentials then restart.

Conclusion

Once all of the above is done, you will hopefully have a working virtual network. When you start all the VMs, remember to start srv-DC first.

Appendix A

Virtual machine details for set up of srv-DC:

/* a lot of these items are default settings, and others will be dependent on host hardware */

General Section

  Basic tab:

    Name: srv-DC

    OS Type: Windows 2008

  Advanced Tab:

    Snapshot Folder: depends on where you set machines folder in global prefs

    Shared Clipboard: Bidirectional

    Removable Media: check remember runtime changes

    Mini Toolbar: check show in fullscreen/seamless; uncheck show at top of screen

System Section

/* these settings may default differently based on host hardware, not sure */

  Motherboard tab:

    Base Memory: 768 MB

    Boot Order: CD/DVD-ROM, Hard Disk

    Extended Features: Both unchecked

  Processor Tab:

    Processor(s): 1

    Extended Features: check Enable PAE/NX

  Acceleration Tab:

    Hardware Virtualization: greyed out on my machine, but:

      VT-x/AMD-V: Enabled

      Nested Paging: Enabled

Display Section

  Video Tab

    Video Memory: 16 MB

    Extended Features: 3D Acceleration: Disabled; 2D Video Acceleration: Disabled

  Remote Display Tab:

    Remote Display Server: Disabled /* but this is a pretty cool feature */
Storage Section

/* The diamond shaped buttons will add or remove controllers. The circle shaped buttons will add or remove attachments from each controller. The IDE controller, when added will have two buttons next to it. One shows a single disk and enables adding a CD/DVD. The other shows multiple disks and enables adding a Hard disk. When you used the wizard to create your VDI, it probably automatically got attached to an IDE controller. You can take advantage of SATA controllers in your host (if present)by removing the VDI that is attached to the IDE controller. You then click the diamond to add a controller. Choose SATA controller. Once the controller is enabled, select it and press the add hard disk button. This adds a disk and automatically sets the association to whatever is first in your Virtual Media Manager. Select the disk that shows up and use the drop down box to point it to the appropriate VDI for this VM */

Storage Tree:

SATA Controller - Attributes: Type: AHCI

  srv-DC.vdi – Slot: SATA PORT 0; uncheck Differencing, Virtual Size 20.00GB

IDE Controller - Attributes: ICH6

  Host Drive ‘F:’ – Slot: IDE Primary Master; uncheck Passthrough

/* For the preceding section, this is how mine looks after the OS is setup. For the very first boot of the machine Proceed as follows:

(If there is no attachment listed under the IDE Controller, select the controller and press the single disk plus icon, then point it to the correct media.)

a. You are using an actual CD/DVD as install media:

a. Select the attachment, then using the CD/DVD Device drop down, point it to the host drive where you will insert the media.

b. You will use an ISO image:

a. Next to the CD/DVD Device drop down, press the folder icon. This opens the Virtual Media Manager.

b. Click the add button.

c. Navigate to the Server 2008 ISO file.

d. Click Open.

e. Click Select.

*/

Audio Section

  Disabled

Network Section:

/* I made each a different type so I could tell the 2 apart easier */
  Adapter 1 Tab:

    Enable checked

    Attached to: Bridged Adapter

    Name: Dependent on host hardware

    Advanced section:

    Adapter Type: Intel PRO/1000 MT Server (82545EM) 

    Cable Connected checked

  Adapter 2 Tab:

    Enable checked

    Attached to: Internal Network

    Name: simwit

    Advanced section:

    Adapter Type: PCnet-FAST III (Am79C973)

    Cable Connected checked

Serial Ports Section:

  Disabled

USB Section:

  Enable USB Controller checked

  Enable USB 2.0 (EHCI) Controller checked

  USB Device Filters area is empty

Shared Folders Section:

/* I added a folder from the host in this section for ease of use. I believe this makes it permanently available although it isn't always connected. To connect from within VM either use the Start menu, right click computer, choose Map network drive and fill in \\vboxsvr\sharename or in cmd prompt type:  net use * \\vboxsvr\sharename */

� Even after a network interface is deleted from the GUI in Windows, various traces of it remain in the registry. These are referred to as ghosted adapters. There is a KB article that may help fix these at: � HYPERLINK "http://support.microsoft.com/kb/955963" ��http://support.microsoft.com/kb/955963�


� Remember, I did this in the wrong order. You should probably try to do srv-SNORT first... just the basic VM setup. If you do decide to create srv-SNORT first: Create the VM, Install the OS, Install the guest additions, and then do the cloning of the VDI file.


� There can be problems on a multihomed DC/DNS server with round robin enabled: � HYPERLINK "http://support.microsoft.com/kb/272294" ��http://support.microsoft.com/kb/272294�





